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Introduction: 

What is Banner? 

Banner is Salt Lake Community College’s (SLCC) administrative software solution.  

This system gathers and distributes information about students from the time they first 

contact the college until they graduate.  Banner also provides access to data pertaining 

to faculty and staff for Human Resources, course catalog, accounts receivable, and 

financial aid.  Banner includes a web interface which enables students and faculty to 

access and update certain portions of their information online.  For example, students 

can register for classes, check their course schedule, and pay their fees, from any 

location via a web browser.  Banner supplies the core needs for a student information 

system, with scalability and flexibility, enabling SLCC’s Office of Information Technology 

(OIT) staff to maintain a state-of-the-art student information system within the 

framework of a modestly sized staff. 

Confidentiality of Data 

Banner is used to access data stored in SLCC’s administrative database.  Much of that 

data is protected by privacy laws.  Access of data should only be done within the 

parameters of job requirements.  An individual’s username sets data access restrictions 

upon logging in to Banner.  However, confidentiality of data should always be 

paramount in the mind of Banner users.  In addition, federal law dictates what and when 

student data can be released to outside entities.  FERPA (Family Educational Rights 

and Privacy Act) is the federal law that establishes student information privacy; what 

can be legally released, and under what conditions.  Banner users should be very 

familiar with what and when data can be released.  For further information about 

FERPA contact the SLCC Registrar Office, 957-4799. 
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Section I:  Getting Started 

Logging on 

Begin by logging into your MyPage web page. 

Log into MyPage: 

1. Go to the SLCC 
Home Web Page 
at www.slcc.edu 
and hover mouse 
pointer over 
MySLCC. 

 

 

 

 

2. From menu, click 
on MyPage. 

 

 

 

This opens the 
MyPage Login page. 

 

 

  

http://www.slcc.edu/
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1. Enter you’re your User Name and Password to 
log into MyPage. 

 

 

 

2. Use this section if you need to get your 
Username and password, 
have forgotten your username or password, or 
need to get your S number. 

 

 

When your MyPage opens, click on the 
Employee tab. 
 

 

 

 

 

On the right side of the page is the Banner 
Forms channel.  Click on the Banner Forms Access link. 

 

The Banner General Menu (GUAGMNU) will 
open in your default browser 
(see screenshot next page). 
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Note: 

 Two Buttons will be displayed in the Windows Taskbar when Banner is loaded; 
a blank browser window and a button with the Java logo (a steaming cup of 
java).  This button is Banner. 

 Closing the blank browser window will force Banner to close. 
 After Banner opens, MyPage can be closed. 
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Using the Mouse and Keyboard 

Navigation in Banner is accomplished with the mouse, keyboard, or a combination of 
the two. 

Using the Mouse 

It is recommended that when using a form with multiple fields, use the Tab key to move 
from one field to another.  Clicking into fields with the mouse can cause errors. 

Keyboard Shortcuts 

Common Banner Keyboard Shortcuts are listed in Appendix E. 

Some keyboard shortcuts are dependent on the current Banner form in use.  Because 
these shortcuts vary from one form to another, they are not described in this manual.   

Show Keys is a valuable tool that lists the keyboard short cuts for the current form. 

To display keyboard short cuts: 

Click on Help in the menu bar and select 
Show Keys from the drop down menu 
list. 

 

The Keys dialog box opens. 
 
It lists Functions and the Key 
sequences that initiate each function for 
the current environment. 
 
To close the Keys dialog box, click OK. 
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Section II:  The Banner Window 

With the form removed, it’s possible to see just the Banner Window.  It’s made up of 
the 6 parts shown below. 

 

Title Bar 

Identifies the platform Banner is built on.  As you open forms in Banner they name of 
the forms are listed in the Title Bar. 

Menu Bar 

The Menu Bar contains drop down menus.  Each drop down menu contains Menu 
Options. 

 

 

Menu options are accessible anytime except when a dialog box, alert box, or a List of 
Values (LOV) open.  These windows require a response before accessing a menu 
option.  Appendix C, contains a complete list of each menu item, its options, and their 
functions. 
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Tool Bar 

The Tool Bar contains buttons that when clicked perform common functions or 
commands. 

 

Hover the mouse pointer hovers over a button and a tool tip describes the function of 
the button.  Appendix D contains a list of the Tool Bar buttons and their functions. 

Form Display Area 

This the Banner Window’s pane and in it forms are displayed.  Note that only one Form 
can be displayed in the window at a time. 

Auto Hint Line 

 

The Auto Hint area at the bottom of the form can contain information for the field where 
the cursor is currently located.  This can include: 

 Brief field description 

 Error and processing messages 

 Keyboard shortcuts, if you can access other blocks, windows, or forms 

Status Bar 

 

The Status Bar directly under Auto Hint can contain one or more of the following 
message: 

 Record # / # - Shows the number of the selected record and the total number of 
records pulled from the database.  If the number records will not fit in the window, 
a question mark appears. 

 Enter Qu… - Indicates the form is in query mode (short for Enter Query). 

 List of Valu… - Indicates the field has a List of Values (LOV). 

Save 

Next Record 

Previous Record 

Enter Query 

Exit Query 

Insert Record 

Remove Record 

Previous Block 

Print Close Button 

Rollback Next Block Execute Query 
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Section III:  All About Forms 

What is a Form? 

A Banner form is an electronic document used for displaying, entering, or editing 
information from the Banner database.  A form visually organizes data into information.   

All SLCC Banner forms are not accessible by all users.  Access permissions are 
determined by a user’s job requirements and username.  Appendix A, contains a list of 
some of the common Banner forms used at SLCC. 

Forms can include Blocks (sections of related records) or a list of Records. 

The General Menu Form that opens when Banner starts is the first form used.  
Understanding the components and terminology of Banner forms will make navigating 
through Banner easier. 

Banner General Menu Form: 

 

 

Note:  Most Menu Items and Tool Buttons are subdued (not active) on General Menu.  
They will become active when another form is selected. 

Title Bar Menu Bar Tool Bar 

Form 
Title Bar Bookmark the 

forms you use 
here 

GoTo… Field 
or 
Direct Access 
command. 

Navigate through 
folders and forms 
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Banner Forms 

There are 8 types of Banner forms, including the General Menu form.  Below is a typical 
form and some of the common components and terminology associated with forms. 

Typical Banner Form Components: 

 

Form Title Bar 

The Form Title Bar contains the Form Description and the Form Name of the opened 
form. 

 

 

 

 

 

Blocks 

Forms are normally divided into Blocks.  Blocks contain related information or records 
such as address records. 

  

Form Description Form Name Minimize Button 

Banner Version Close Form 

Form 
Title Bar 

Key Block 

Other Blocks 
Indicated by 
Tabs 
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Key Block 

The information in the Key Block determines what is entered or displayed in the rest of 
the blocks on the form. 

Note:  All information on the form refers to the key block information. 

Other Blocks 

Other Blocks contain additional information related to the Key Block.  They are usually 
bounded by a beveled line box. 

Elements of a Form: 

The following figure shows various elements that appear on forms.  A description of 
each element is on the following pages. 

 

  

Buttons 

Fields 

Check Boxes and 
Option buttons. 

Record 

Form Name 



SLCC Banner 
Basics and Navigation 

SLCC Banner Basics and Navigation Page 11 
Office of Information Technology Feb. 2016 

Form Name 

Each form has a unique name.  The name is a 7-letter identifier that is developed from a 
matrix.  In the above form the name GUAMESG can be broken down as follow: 

The 1st letter identifies the primary 
system owning the form. 

G = General 

The 2nd letter identifies the module 
owning the form. 

U = Utility 

The 3rd letter identifies the type of 
form. 

A = Application Form 

Letters 4 - 7 are an abbreviation of 
the forms function. 

MESG = Message 

Appendix B contains the Banner Form Naming Matrix used to create form names. 

Fields 

Banner forms contain mostly Fields.  Fields are boxes used to display, enter, or edit 
data.  A group of related data fields make up a Record.  Each field in the record 
contains data that alone may not be informative.  Related data fields are grouped 
together to form a record which conveys information.  An example would be the address 
record that follows. 

 Each Field contains a 
data item from the 
database. 

 Grouped, related data is 
a Record. 

Example: Grouped data 
creates this address record. 

 Grouped, related data is 
a record and conveys 
information. 

 

 

 

 

Buttons 

Buttons are visual images that, when clicked, send a command to Banner.  Buttons are 
generally associated with a field and perform actions associated with the field.  The 
following table displays Banner form Buttons and their purpose. 
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The Search or List button opens a list or search 
form allowing selection of a value that will insert 
into the field.  

The Calendar button opens a calendar window 
for selecting a date. 

 

The Data button indicates that data is available. 

 

The presence of a No Data button indicates that 
no data is available for the field. 

 

The Summary button displays summary 
information for the associated record. 

 

The Details button displays details for the 
associated record. 

 

The In Process button indicates that the 
process has started but not completed. 

 

The Complete button indicates the process is 
complete. 

 

The Maintenance button updates information in 
the database. 

 

The Copy button copies the current record or 
records. 

 

The Comments button displays a window where 
you can enter comments about the associated 
record.  

The Calculate button performs a calculation on 
data in the associated field. 

 



SLCC Banner 
Basics and Navigation 

SLCC Banner Basics and Navigation Page 13 
Office of Information Technology Feb. 2016 

The Approve button indicates that the process 
is approved. 

 

The Disapprove button indicates the process is 
not approved. 

 

The Generate ID button generates a new ID. 

 

Response buttons appear when the system 
requires a user input.  A user must click on a 
response button to continue.  

Radio buttons are small circles used to select 
one of several options.  Clicking in a circle 
causes a dot to appear indicating selection of 
that option.  

Check Boxes 

Check boxes are used to turn on or off features or options.  

Click on the empty Check Box to turn an option 
on.  Click on the check marked Check Box to 
turn an option off.  The option is turned off when 
the check box is empty. 

 

 

Section III:  Navigating through Banner 

Banner provides numerous ways to navigate through the system.  Following is a list of 
navigation options and a brief description of each. 

General Menu 
Allows selection from a list of menus, 
forms, jobs, and Quick Flows. 

Direct Access 
Allows direct access to a form, job, or 
QuickFlow by entering its name. 

Object Search 
Allows access to a form, job, or 
QuickFlow if you know part of its name, 
description, or type. 
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Options Menu 
This feature allows accessing other 
forms, windows, and blocks related to the 
current form, window, and block. 

Options Window 

Like the Options Menu, it contains 
different options related to a form, such 
as saving, navigating to another window, 
or to another form. 

Last 10 forms accessed 
Allows quick re-access to a form that was 
previously opened in the current session. 

 

Navigation Options 

The My Banner Folder 

Banner opens to the General Menu (GUAGMNU) form.  It displays two folders; Banner 
and My Banner. 

The My Banner folder is your personal folder where you can bookmark the Banner 
forms used most.  The form names are links that when selected will open the form itself. 

Open Forms Using the My Banner folder 

The General Menu form opens with the 
My Banner folder open and its contents 
displayed below. 

Double click on a form name to open 
that form. 

 

To insert forms into the My Banner folder 

Navigate to the form you wish to add to 
the My Banner folder.  When it opens, 
get data in the form then right click on 
the form anywhere but in a field.  The 
Options Window opens. 

In the Options Window, select Add to 
Personal Menu. 
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Note:  You can also use the form GUAPMNU to insert, edit and delete forms in you’re 
My Banner folder.  Instruction for using this form are in the Setting User Preferences 
document found on the OIT Training website. 

 

Direct Access or Go to Field 

If the name of the form is known, Direct Access, also known as the Go to field can be 
used to directly access the form without going through the folder. 

To use Direct Access: 

Enter the name of the form in the Go to... 
field of the General Menu. 

Press the Enter key on the keyboard. 

 

 

 

 

 

 

 

 

Object Search 

Use Object Search to access a form, job, or QuickFlow with only part of the name, 
description, and/or type. 

To use Object Search: 

On the General Menu, Double click in 
the Go to... field or click the Search 
button. 

 

 

The Object Search Form (GUIOBJS) opens.  Enter known information in the Name, 
Description, and/or Type fields.  You must use the wildcard character % for partial 
Names.  (See Wildcards) 

Continue using the same procedures to 
add all the forms you want in you’re My 
Banner folder. 

Log out of Banner and log back in and the 
forms will appear in you’re my Banner 
folder. 

 

Hint:  Make of a list of the forms in the 
order you want them in you’re My Banner 
folder before adding them. 

 

https://slcc.service-now.com/help/oit_training.do
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In the Name field enter as much of the 
name as possible.  The wildcard 
character % must be used for incomplete 
names.  

Enter any part of the descriptive name 
in the Description field.  The wildcard 
character % must be used for incomplete 
descriptions.  

Click the pull down menu button and 
select the type of object, i.e. Form. 

 

Execute the query (search) by selecting 
Execute from the Query menu or 
pressing the F8 key on the keyboard. 

 

The Object Search window reopens displaying a list of all matches found.  In the 
example, 3 forms matched the search criteria.  Note:  the Start, Clear, and Cancel 
buttons are now active. 



SLCC Banner 
Basics and Navigation 

SLCC Banner Basics and Navigation Page 17 
Office of Information Technology Feb. 2016 

 

To open the desired object: 

Scroll to the desired object and click on 
it to select.  This highlights the Name 
and the 3 fields.  

Click the Start button to open the object. 
 

Click the Clear button to clear all fields 
to begin a new search.  

Click the Cancel button to cancel the 
search and return to the General Menu.  

Note:  With the cursor in the Go to... field, use the Up and Down arrow keyboard keys 
to scroll through forms previously accessed. 

The Options Menu: 

Click on Options in the Menu Bar and 
then select the desired option. 

 

The Options Window 

The Options Window is opened by Right Clicking anywhere on a form (except within 
a field).  Like the Options Menu, it contains different options related to a form, such as 
saving, navigating to another window, or form, etc. 
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Right click on the form.  The Option 
Window opens.  Click on an option from 
the window to select it. 
 
Top of Option Window contains options 
that are the same for all forms. 
 
Lower of window contains options that 
vary dependent on Form and mirror 
Menu Options in the Options Menu. 

 

 

Last 10 Forms accessed 

A form that was previously opened in the current session can be quickly accessed using 
this feature.  The bottom of the File menu contains a list of the last 10 forms opened in 
the session with the most recently opened on top. 

To use the Last 10 Forms features 

Click File from the Menu bar. 
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At the bottom of the drop-down menu is 
the list of forms.  Click on the desired 
form to open. 

 

 

Direct Access Field 

The Direct Access Field or Go To... field opens below the Title Bar of the form 
currently opened.  The Direct Access Field functions exactly like the Go To... field on 
GUAGMNU allowing quick navigation to other forms. 

To display and use the Direct Access Field: 

From any form, press the F5 key on the keyboard.  This opens the Direct Access 
Field.  

 

Enter the name of the form in the Go To... field and Press Enter on the keyboard. 
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Navigation within Forms 

Banner provides functions for navigating within a form: 

Button / 
Keystroke 

Function Purpose 

  / 

Shift + F7 

Roll Back 

Note:  The Rollback 
function operates 
differently depending 
on the type of form 
opened. 

Application and Inquiry Forms: 
Clears all information (except key 
information) and cursor returns to the 
first enterable field in the key block. 

Validation Forms: 
Returns cursor to the first enterable 
field on the form. 

Query Forms: 
Returns cursor to the first enterable 
field on the calling form. 

  / 

Ctrl + Page Down 

Next Block 

Moves the cursor to the next block that 
has as at least one enterable field.  If 
the next block is in another window, that 
window is opened. 

  / 

Ctrl + Page Up 

Previous Block 

Moves the cursor to the previous block 
that has at least one enterable field.  If 
the previous block is in another window, 
that window is opened. 

  / 

Down Arrow 

Next Record 

 

Moves the cursor to the first enterable 
field in the next record of the current 
block.  Note:  If the cursor is in the last 
record, a new blank record is created. 

  / 

Up Arrow 

Previous Record 

 

Moves the cursor to the first enterable 
field in the previous record. 
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Entering Data 

Entering Data into Validated Fields 

A Validated Field on a form accepts only data or a value from a List of Values (LOV).  
An example would be a field for State in an address record.  Only one state listed in the 
LOV can be selected. 

There are 3 ways to enter a value: 

 Enter the complete value if the value is known 

 Enter a partial value 

 Display the entire LOV and select a value 

Enter the Complete Value: 

Enter the full value in the field, for 
example, UT for Utah. 

 

Press the Enter key on the keyboard.  
If there is a match in the LOV, it 
appears in the field. 

Note:  In some forms, when Enter is 
pressed and a match is found the 
cursor moves to the next field, i.e. Zip 
Code. 

 

If no match is found, an Error 
message appears in the Auto Hint 
area at the bottom of the window.  

Enter a Partial Value 

Enter as much of the value as known, 
for example U%.  The percent symbol 
(%) is the wildcard used to represent 
any unknown characters.  Press the 
Enter key on the keyboard.  

If only 1 match is found, it will display in 
the field. 
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If 2 or more matches are found, they 
will display in a Search Results window. 

Select the desired value and click OK. 

 

The selected value will display in the 
field. 

 

Display the entire LOV: 

Click on the Search button for the 
field. 

 

The List of Values (LOV) for the field 
will appear.  Navigate to the desired 
value, select it, and click OK. 

 

The value displays in the field. 
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Entering Information from another Form (or Called Form) 

Sometimes clicking on the Search button next to a field will open another form known 
as a Called Form.  Information can be selected from this Called Form, and returned to 
the current field. 

To enter information in a field from a Called Form: 

Click on the Search button next to the 
right of the field. 

 

If an Option List appears (as in the 
example) click the desired option to 
display the form, 

otherwise, 

the Called Form opens automatically. 

 

When the Called Form opens, enter 
the search criteria. 

Press the Execute Query button (see 
arrow) or Press F8 to execute query. 

The form displays matching values. 
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Scroll (if necessary) to the desired 
value on the called form. 

Double click the desired value. 

 

The Called form closes, the previous 
form opens, and the selected value 
returns to the field of current form. 

 

 

Entering IDs or Names 

Many Banner Forms have ID and Name fields for persons and non-persons.  For 
persons, the SLCC ID or the Social Security Number (SSN) can be used.  There are 
several ways to enter an ID or Name. 

Enter a Complete ID: 

If the entire ID is known, enter it into the 
ID field. 
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After entering the last digit, if a match is 
found, Banner will immediately fill the 
Name field. 

 

If no match is found, the Error message 
"ID does not exist, press LIST for 
Name/ID search." 
displays in the Auto Hint area at the 
bottom of the window. 

Note:  The List referred to is in the Help 
menu.  Selecting List opens the Person 
Search form, SOAIDEN. 

 

 

Enter a Complete Name: 

Make sure the ID field is blank.  Press 
the Tab key to move the cursor to the 
Name field. 

 

Enter the full Name. 

Note: The name format must be, Last, 
First, Middle with a comma between 
each name.  Upper or lower case letters 
can be used. 
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Press the Enter key.  If one match is 
found the Name field is filled.  

If multiple matches are found, the 
Name Extended Search window opens 
from which the desired name can be 
selected. 

 

 

Enter a Partial ID: 

Enter a Partial ID in the ID field using the known values and the % symbol as a wildcard 
representing unknown values.  For example:  

Enter the partial ID in the ID field with 
the known characters and using the 
wildcard symbol (%) for the unknown 
characters. 

 

Press the Enter key.  If one match is 
found the name and complete ID are 
returned to the form. 

If multiple matches are found, the 
Extended Search window opens 
allowing selection of the desired ID and 
name. 

Note:  More search criteria may be 
entered in this window to reduce the 
number of records returned. 
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Enter a Partial name: 

Make sure the ID field is blank and 
Press the Tab key to move the cursor 
to the Name field. 

 

Enter the partial Name in the Name 
field with the known characters and 

using the wildcard symbol % for the 

unknown characters.  

 

Press the Enter key.  If one match is 
found the name is returned to the form. 

If multiple matches are found, the 
Extended Search window opens 
allowing selection of the desired ID and 
name. 

 

 

Enter by SSN: 

If the SSN of an individual is known, it can be entered to find their records. 

In the blank ID field, enter the SSN of 
the person. 
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If a match is found, immediately after 
entering the last digit of the SSN, the 
name field will be filled with the 
individual's name. 

Note:  The SSN will also immediately 
change to the Banner ID number. 

 

 

Querying (Searching) for Information 

A Query is a search for information from a database.  Queries for information from the 
SLCC database can be made using most Banner forms.  Querying the database is 
done either by selecting values from a menu or entering values into a blank field or 
fields. 

This section discusses Query Functions and how to search the database for 
information using Queries. 

Query Functions 

Query Functions are accessed from the Query Menu located on the Menu Bar.  Use 
the following functions to perform queries: 

Enter 

The Enter function, on certain forms, puts the form 
into Query mode to allow entering search values.  
Enter Query appears in the Status Line at the bottom 
of the window when the form is in Query mode. 

Execute 

Executes (or runs) the Query search based on the 
values entered.  Records that match will be returned 
to the form. 
Note:  Implement the Execute function also by 
pressing the Execute Button in the Tool Bar or 
pressing the F8 key. 

http://www.webopedia.com/TERM/q/database.html
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Last Criteria 

Enters the criteria or values from the last search.  
The values can then be edited or changed. 
To use, select Last Criteria and the form will clear.  
Select Last Criteria a second time and the previous 
search criteria will display. 

Exit or Cancel 

Cancels the Query and takes the form out of query 
mode. 
or 
If the form is not in query mode the Cancel option 
closes the form. 

Count Query Hits 
Counts the number of records returned from the 
query and displays that number in the Auto Hint area 
at the bottom of the window. 

Fetch Next Set 
Opens the next set of records if more records match 
the search criteria than fit in the window. 

 

Query Wildcards 

Wildcards are symbols used to represent an unknown value or string of values when 
entering query search criteria.  The two symbols used are: 

 The % (percent) symbol represents any number of unknown characters. 

 The _ (underscore) symbol represents one unknown character. 

The following examples illustrate the use of Wildcards: 

To get these results: Enter this criteria: 

All entries that contain "mas" %mas% 

All entries that begin with "mas" mas% 

All entries that end with "mas" %mas 

All entries of "Hanson" where the second to last 
letter could be ‘e’, ‘o’, etc. 

Hans_n 

All entries where the second character is "m". _m% 
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How to Query using Banner 

To Query Information: 

Access the form that contains the data 
fields that are to be searched. 

Note:  If the form does not open in 
Query mode, select Enter from the 
Query Menu or press F7 on the 
keyboard. 

 

With the form in Query mode enter the 
search values.  Enter values into any 
accessible field.  The Wildcard 
characters % (percent) and _ 
(underscore) may be used.  
Capitalization matters.  Banner 
searches for data that exactly matches 
entered values. 

 

Select Execute from the Query menu 
or press the F8 key.  The form displays 
all records that match the search values. 

Note: Returned records, in the example, 
match the values based on wildcard 
characters used. 
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To change the search values and re-query: 

With the original search results 
displayed, select Last Criteria from the 
Query menu or press F7 on the 
keyboard. 

 

The displayed records will be removed.  
Select Last Criteria or press F7 again. 
The original search values are 
displayed.  

 

Revise the search values as required 
and execute the Query again.  
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To Query a Checked Check Box: 

With the form in Query mode, select 
(Check) the Check Box. 

Enter additional search criteria as 
required.  (Optional) 

Select Execute query.  The form 
displays records that have the Check 
Box checked. 

 

 

Date Queries 

Date queries require special care.  The Date Format must be exact.  Also, Banner 
stores dates with a Time Stamp.   

The solutions to get the desired result are discussed below. 

Date Format 

Banner stores dates in a specific format, 
dd-mon-yyyy. 

Queries on a date field must follow this 
format exactly for dates to be retrieved. 

Example:  23-Aug-2014 

or: 05-Jun-2015 

Note:  If the century digits of the year are 
omitted, Banner enters zeros.   

If 05-Jun-15 is entered 

 it becomes  

05-Jun-0015. 

 

Time Stamps 

When querying on a specific date, Banner will add the time stamp "00:00:00" to the 
criteria.  This will result in the message Query caused no records to be retrieved.  
Re-enter.  To obtain the desired results do the following: 

Use a relational operator with an earlier 
and/or later date. 
For example, to find records dated: 

23-Aug-2015 
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Use the > (Greater Than) and < (Less 

Than) operators: 

>22-Aug-2014 and 

<24-Aug-2015 

The query results will include all records 
dated: 

After 22-Aug-2014 and  

Before 24-Aug-2015 

 

Printing from Banner 

There is a Print menu option on the File menu, and a Print button on the Tool Bar. 

Banner uses the Windows Alt+Print Screen function when either is pressed.  Only a 
picture of the Banner window is printed. 

To Use the Banner Print Function: 

From the Menu Bar select File > Print 
or 
From the Tool Bar click the Print 
button. 

 

The Print dialogue box will open. 

Select the number of copies needed. 

Press OK. 

The Banner window currently displayed 
will be printed. 

 

Note:  This basic printing function in Banner is similar to pressing Alt + Print Screen on 
the keyboard.  A screen shot of the Banner window is captured and that is what prints. 
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Appendices 

Appendix A:  Examples of Banner Forms 

Note:  The username sets what forms the user can access when the user logs on.  Not 
            all users will have access to all of these forms. 

Area Form Name Purpose/Description 

Personal 
Data 

SPAIDEN 

 Generate a new general and/or student ID 
number. 

 Look up a student by name. 

 Display alternative names/IDs.  (% used as a 
wildcard on name search.) 

 Displays student addresses, gender, birth date, 
social security number, confidentiality flag, 
citizenship, ethnicity, marital status, 
deceased/date, etc. 

 GOAMTCH 
 Search for existing records when generating 

new SPAIDEN records. 

Admissions SAAADMS 
 Display application information including, date 

applied, entry term, major, residency status, etc. 

 Display missing information for the student. 

 SGASTDN 
 Display student application information such as 

major, residency status, veterans information, 
etc. 

 SOAHSCH  Display student high school information. 

 SPACMNT  Display notes related to residency, billing, etc. 

Transfer SOAPCOL 
 Display other colleges the student attended, any 

transcripts received, and if transcripts have been 
reviewed. 

 SHATATR 
 Display, by institution, transferring courses and 

equivalent SLCC courses. 

 SHATRNS  Display transfer credit awarded. 

Registration SOADEST 
 Use to set destination printer for schedules, 

invoices, transcripts, enrollments, and 
compliance reports. 
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Area Form Name Purpose/Description 

 TOADEST 
 Use to set destination printer for invoices, 

receipts, and student summary reports. 

 SOATEST 
 Display scores of all tests the student has taken 

(CPT, ACT, etc.) 

 SOAHOLD  Display hold type and reason. 

 SFARGRP  Display registration dates by semester/term. 

 SFASRPO  Display priority ticket information. 

Reg. (cont.) SFASTCA  Display student registration activity for the term. 

 SFAREGS 
 Use only to register students, not to look up 

their schedule. 

 SWAREGS  Use to print a schedule of classes for a student. 

 SFAREGQ  Display a student’s semester/term schedule. 

Tuition/ 
Account 

SFAREGF 
 Display tuition, fees and any other charges on 

student account for current term.  (Must input ID 
number, next block & enter.) 

 TSAAREV  Display student’s account detail. 

Class Look-
up 

STVMAJR  Financial Aid program eligibility 

 SSASECQ 
 Use to query class information (course, section, 

availability, etc.). 

 SSASECT 
 Display specifics on a particular class – use 

CRN. 

 SCACRSE  Display school and division in charge of course. 

 SFASLST  Display class roster. 

 SFRSLST  Print a class roster. 

 SIAASGQ  Display faculty teaching schedule. 

 SFAREGQ  Look up a student’s schedule. 

Transcripts/ 
History 

SHATERM 
 Display a student’s completed coursework by 

term. 

 SHACRSE  Display semester/term schedule and grades. 
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Area Form Name Purpose/Description 

 SHASUBJ  Display a student’s coursework by subject. 

 SHARQTC  Use to request a transcript. 

CAPP- 
Degree Audit 

SMARQCM 

 Use to create and view compliance requests. 

 Create and view planned courses. 

 Create and view hardcopy output requests. 

 Display how many compliances have been run 
on the individual student. 

 SMASADJ 

 Use to create or view course substitutions and 
waivers that are entered into a student’s 
program. 

 Notations are made on this screen regarding 
reasons for course, substitutions, waivers, etc. 

 SMAPRLE 
 Display a complete list of programs available to 

run a CAPP compliance. 

 

 SMIPROG 
 Display a complete list of programs available to 

run a CAPP compliance. 

 SMICRTL 
 Use to view on screen, by area, which areas 

have been met or not met. 

Graduation SHADEGR  Display student’s graduation information. 

 SHADGMQ  Display degree summary information. 

Time Entry PHATIME  Employee Time Entry form. 

Return to Table of Contents 
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Appendix B:  Banner Form Naming Matrix 

Each Form used in Banner has a unique Name and Description.  The Form Name is 7 
letters.  The following matrix is used to determine the form name and aid the user in 
identifying the purpose and/or description of a form. 

1st Letter 

Identifies the 
Primary 
System 
owning the 
form. 

A  Advancement 

F  Finance 

G  General 

P  HR/Payroll/Personnel 

R  Financial Aid 

S  Student 

 

2nd Letter 

Identifies the 
Module 
owning the 
form. 

Advancement (A) Financial Aid (R) 
HR/Payroll/Personnel 
(P) 
Position Control (N) 

A  Advancement B  Budgeting A  Application 

D  Designation C  Record Creation B  Budget 

E  Event Management E  Electronic Data 
    Exchange 

C  COBRA 

F  Campaign F  Funds Management D  Benefit/Deduction 

G  Pledge and Gift/Pledge 
     Payment 

H  History and Transcripts E  Employee 

J  Student Employment H  Time Reporting/History 

L  Label L  Logging O  Overall 

M  Prospect Management N  Need Analysis P  General Person 

O  Organization O  Common Functions R  Electronic Approvals 

P  Constituent/Person 
P  Packaging & 
    Disbursements 

S  Security 

S  Solicitor Organization R  Requirements Tracking T  Validation/Rule Table 

T  Validation Form/Table S  Student System Shared 
    Data 

U  Utility 

U  Utility T  Validation Form/Table V  Reserved 

V  Reserved U  Utility 
X  Tax Administration 

X  Expected Matching Gift V  Reserved 
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2nd Letter 

Identifies the 
Module 
owning the 
form. 

(Cont.) 

Finance (F) General (G) Student (S) 

A  Accounts Payable E  Event Management A  Admissions 

B  Budget Development J  Job Submission C  Catalog 

C  Cost Accounting L  Letter Generation E  Support services 

E  Electronic Data 
     Interchange 

O  Overall 
F  Registration/Fee 
     Assessment 

F  Fixed Assets P  Purge G  General Student 

G  General Ledger S  Security H  Grades/Academic 
     History 

I  Investment Management T  Validation Form/Table I  Faculty Load 

N  Endowment 
    Management 

U  Utility K  Reserved – SCT 
     International.  UK 

O  Operations V  Reserved L  location Management 

P  Purchasing/Procurement X  Cross Product M  CAPP 

R  Research Accounting  O  Overall 

S  Stores Inventory  P  person 

T  Validation Form/Table  R  Recruiting 

U  Utility  S  Schedule 

V  Reserved  T  Validation Form/Table 

X  Archive Purge  U  Utility 

  V  Reserved – Can. 
     Solution Ctr. 

All Products 

W  Reserved for client forms or modules used within a Banner 
application 
X   (character in Letter 1 position does not equal W, Y, or Z) 
Z 
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3rd Letter 

Identifies the 
Type of 
form.  

Advancement (A) Financial Aid (R) 
HR/Payroll/Personnel 
(P) 
   Position Control (N) 

A  Application Form A  Application Form A  Application Form 

B  Base  Table B  Base  Table B  Base  Table 
     Batch COBOL process C  Called/List Form I  Inquiry Form 

I  Inquiry Form P  Process/Report I  Inquiry Form 

P  Process/Report 
R  Rule Table 
    Repeating Rules Table 
    Report 

P  Process/Report 

R  Repeating Rules Table 
R  Rule Table 
    Repeating Rules Table 
    Report/Process 

T  Temporary Table 

V  Validation Form 
     View 

T  Temporary Table 

V  Validation Form/Table 
     View 

V  Validation Form/Table 

Finance (F) General (G) Student (S) 

A  Application Form A  Application Form A  Application Form 

B  Base  Table B  Base  Table 
     Batch COBOL process 

B  Base  Table 

I  Inquiry Form I  Inquiry Form 

M  Maintenance Form I  Inquiry Form P  Process 

Q  Query Form O  Online COBOL Process Q  Query Form 

R  Rule Table 
    Repeating Rules Table 
    Report/Process 

Q  Query Form 
R  Rule Table 
    Repeating Rules Table 
    Report/Process 

R  Rule Table 
    Repeating Rules Table 
    Report/Process 

V  Validation Form/Table 
     View 

V  Validation Form/Table 
     View 

T  General Maintenance 
    Temporary Table   
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4th, 5th, 6th, and 7th letters:  These form a four letter abbreviation of the forms purpose.  
For example, IDEN = identification, REQN + requisition, etc. 

 

Example:  Below are examples of 3 Forms and their Naming Structure: 

SPAIDEN GJRRPTS FPIREQN 

S Student G General F Finance 

P Person J Job Submission P Procurement 

A Application Form R Report/Process I Inquiry Form 

IDEN Identification RPTS Reports REQN Requisition Query 

 

Return to Table of Contents 
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Appendix C:  Menu Bar Options 

The Menu Bar contains Drop-down Menus.  Each Drop-down Menu contains Menu 
Options.  Clicking on a Drop-down Menu name opens its Menu Options list.  Clicking 
on a Menu Option selects it. 

 

 

 

File Menu 

The File Drop-down Menu contains standard Banner functions.  The bottom of the File 
Drop-down Menu lists the last forms (up to 10) that were accessed in the current 
session.  Selecting one of these forms will open it. 

 Menu Option Function 

 
Direct Access Displays the Direct Access Form (GUAPARM) 

which is used to access a form by its name.  See 
Direct Access. 

 
Object 
Search 

Displays the Object Search Form (GUIOBJS) 
which is used to search for a form with part of the 
name or description.  See Object Search. 

 
QuickFlow Displays the QuickFlow Form (GUAQFLW) which 

is used to access a QuickFlow. 

 
Select Returns the user to the calling form and enters the 

selected value into the form. 

 

Rollback  Application Forms – Clears all information 
except Key Block information. 

 Validation Forms – Returns the cursor to 
the first enterable field in the form. 

 Query Forms - Returns the cursor to the 
first enterable field in the calling form. 

 Save Saves all information entered since the last save. 

 Refresh Clears the message line. 

 
Print Prints the current window with the date and time in 

the Title Bar. 

 
Exit  In Forms and Windows – Exits the Form or 

Window 

 In General Menu – Exits Banner 

Menu Bar 
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 In Query Mode – Cancels the query and 
takes the form out of query mode. 

 
Exit 
QuickFlow 

Exits a QuickFlow. 

 
Exit SCT 
Banner 

Exits Banner. 

 
Return to 
Menu 

Returns the user to the General Menu Form 
(GUAGMNU). 

 Preferences 
Displays the General User Preferences 
Maintenance Form (GUAUPRF), used to 
customize Banner for personal preferences. 

 

Edit Menu 

The Edit Drop-down Menu contains functions used to edit text items. 

 Menu Option Function 

 
Cut 

Cuts selected text and places it on the computer 
clipboard. 

 
Copy 

Copies selected text and places it on the computer 
clipboard. 

 
Paste 

Copies the text from the computer clipboard to the 
selected area. 

 
Edit 

Displays the Editor window which is used to enter 
or update text. 

 

Options Menu 

The Options Menu contains Menu Options that change based on the form currently 
open and where the cursor is located within the form.  Some Menu Options access 
other blocks and windows within the current form.  Other Menu Options access related 
forms outside the current form. 
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Block Menu 

The Block, Drop-down Menu contains functions used to navigate among the blocks of 
information on a form. 

 Menu Option Function 

 
Next 

Moves the cursor to the next block that has at least 
one enterable field.  If the next area is in another 
window, that window is opened. 

 
Previous 

Moves the cursor to the previous block that has at 
least one enterable field.  If the previous area is in 
another window, that window is opened. 

 
Clear 

Clears all information from the current block.  
(Information is not deleted from the database.) 

 

Item Menu 

The Item Drop-down Menu contains functions used to navigate among the fields, also 
called items, on a form. 

 Menu Option Function 

 Previous 
Moves the cursor to the previous enterable field 
(item) in the current block. 

 Next 
Moves the cursor to the next enterable field in the 
current block.  Occasionally, Next Item moves the 
cursor to the first enterable field in the next block. 

 Clear 
Clears all information from the current field.  
(Information is not deleted from the database.) 

 Duplicate 
In a blank row of a repeating record, duplicates the 
contents of the same field in the previous record 
and copies it into the new record. 
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Record Menu 

The Record Drop-down Menu contains the functions used to work with records on a 
form. 

 Menu Option Function 

 
Previous 

Moves the cursor to the first enterable field in the 
previous record. 

 
Next 

Moves the cursor to the first enterable field in the 
next record of the current block.  If the cursor is in 
the last record, a new record is created. 

 
Scroll Up 

Scrolls a list of records up one page.  The first 
displayed record prior to selecting Scroll Up will be 
displayed at the bottom of the list. 

 
Scroll Down 

Scrolls a list of records down one page.  The last 
displayed record prior to selecting Scroll Down will 
be displayed at the top of the list. 

 
Clear 

Clears all information from the current record.  
(Information is not deleted from the database.) 

 
Remove 

Deletes all information for the current record.  
Selecting Save then deletes the information from 
the database. 

 
Insert 

Inserts a new blank record into the list of existing 
records. 

 
Duplicate 

Duplicates the contents of all fields in the selected 
record and copies them into a new record. 

 
Lock 

Temporarily locks the contents of a record so no 
other Banner user can update it.  Save, Rollback, 
or Exit release the lock. 
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Query Menu 

The Query Drop-down Menu contains the functions used to search or query for 
information in the database based on specific search criteria. 

 Menu Option Function 

 
Enter 

Puts the form into query mode so search criteria 
can be entered. 

 
Execute 

Initiates the search for information based on 
entered search criteria.  Information matching the 
criteria is then displayed in a set of records. 

 
Last Criteria 

Selecting this once clears any matching 
information.  Selecting it a second time re-enters 
the criteria from your last search. 

 
Cancel 

Cancels the query and takes the form out of query 
mode. 

 
Count Hits 

Counts the number of records that match the 
search criteria and displays the number in the Auto 
Hint area. 

 
Fetch Next 
Set 

If more records match the search criteria than fit in 
the window, replaces the current set of displayed 
records with the next set. 

 

Tools Menu 

The Tools Drop-down Menu contains actions that can be performed with Banner 
Xtender Solutions as well as options to submit or release a SCT WorkFlow. 
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Help Menu 

 Menu Option Function 

 
Online Help 

Opens the Banner Help Center web page with 
information for the current form. 

 
Dynamic 
Help Query 

Displays the Dynamic Help Form (GUAHELP) in 
query mode.  This is used to display information 
for a field, block, or form. 

 
Dynamic 
Help Edit 

This is a maintenance function not available to all 
users.  It is used to edit the Dynamic Help 
information displayed. 

 Help (Item or 
field 
Properties) 

Displays the database item or field properties for 
the current field. 

 
Show Keys 

Displays a list of Functions and the keyboard key 
strokes to access them.  The list will change based 
on the current form, window, and/or field. 

 
List 

If the cursor is currently in a field that has a LOV 
(list of values), the list will be displayed. 

 Display Error If a database error occurs, displays the error code. 

 Display ID 
Image 

If the cursor is in an ID field, displays an image 
associated with the ID if one is available. 

 Calendar Displays the calendar. 

 Calculator Displays the calculator. 

 Extract Data 
with Key 

Extracts Banner data for the current block, with 
key data, to a spreadsheet. 

 Extract Data 
No Key 

Extracts Banner data for the current block, without 
key data, to a spreadsheet. 

 
Technical 
Support 

Turns on a tool that helps the technical support 
staff track performance issues and expedite a 
resolution. 

 
About SCT 
Banner 

Displays the About SCT Banner Form 
(GUAABOT), which displays the current form, 
release number, date, and time. 

 

Return to Table of Contents 
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Appendix D:  Tool Bar Buttons 

 

The Tool Bar contains buttons that perform common functions.  They provide quick 
access to Banner functions without using Menu Items in the Menu Bar or using 
keyboard key strokes. 

Button Name Function 

 
Save 

Saves all changes to a form, block, or field to the 
database since the last save. 

 
Rollback 

 Application Forms – Clears all information 
except Key Block information. 

 Validation Forms – Returns the cursor to the 
first enterable field in the form. 

 Query Forms - Returns the cursor to the first 
enterable field in the calling form. 

 
Select 

Returns the user to the calling form and enters the 
selected value into the form. 

 
Insert Record 

Inserts a new blank record into the list of existing 
records. 

 
Remove Record 

Deletes all information for the current record.  
Selecting Save then deletes the information from 
the database. 

 
Previous Record 

Moves the cursor to the first enterable field in the 
previous record. 

 
Next Record 

Moves the cursor to the first enterable field in the 
next record of the current block.  If the cursor is in 
the last record, a new record is created. 

 
Previous Block 

Moves the cursor to the previous block that has at 
least one enterable field.  If the previous area is in 
another window, that window is opened. 

 
Next Block 

Moves the cursor to the next block that has at least 
one enterable field.  If the next area is in another 
window, that window is opened. 

 
Enter Query 

Puts the form into query mode so search criteria 
can be entered. 
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Execute Query 

Initiates the search for information based on 
entered search criteria.  Information matching the 
criteria is then displayed in a set of records. 

 
Cancel Query 

Cancels the query and takes the form out of query 
mode. 

 

View/Send 
Message 

Used to send messages to and receive messages 
from other Banner users.  Can also be used to 
query messages. 

 
Print 

Prints the current window with the date and time in 
the Title Bar. 

 

Set Banner 
Xtender Solutions 
(BXS) 

Not used at SLCC. 

 

BXS – Add 
Document 

Not used at SLCC. 

 

Workflow Submit Adds a WorkFlow. 

 
Workflow Release Releases a WorkFlow 

 

Broadcast 
Messages 

Displays a broadcast message if available. 

 
FGAC Security Not used at SLCC. 

 
Online Help 

Opens the Banner Help Center web page with 
information for the current form. 

 
Exit 

 When in any form other than the General 
Menu Form (GUAGMNU), exits that form and 
opens the General Menu Form. 

 When in the General menu Form, exits 
Banner. 

Return to Table of Contents 
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Appendix E:  Keyboard Shortcuts 

The following table contains Keyboard Shortcuts to commonly used Commands and 
Functions: 

Command 
Keyboard 
Shortcut 

Function 

Rollback Shift + F7 

 Application Forms – Clears all information 
except Key Block information. 

 Validation Forms – Returns the cursor to 
the first enterable field in the form. 

 Query Forms - Returns the cursor to the 
first enterable field in the calling form. 

Save F10 
Saves all changes to a form, block, or field to the 
database since the last save. 

Exit Ctrl + Q 

 From any form except General Menu 
Form (GUAGMNU), exits that form and 
opens General Menu Form. 

 When in General menu Form, exits 
Banner. 

List of Values F9  Displays a list of valid choices for the field. 

Navigation 
Window 

F5 
Displays a Navigation Window in the current 
form allowing quick access to another form. 

Print Shift + F8 Print the current form window. 

Search Shift + F2 View Search (Doesn’t work on every form. 

Run (Execute) 
Query 

F8 
Initiates the search for information based on 
entered search criteria.  Information matching 
the criteria is then displayed in a set of records. 

Enter (Clear) 
Query 

F7 Establishes or clears a database search. 

Next  Block 
Ctrl + Page 
Down 

Moves cursor to next block that has at least one 
enterable field.  If next area is in another window, 
that window is opened. 

Previous Block Ctrl + Page Up 
Moves cursor to previous block that has at least 
one enterable field.  If previous area is in another 
window, that window is opened. 
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Clear Data in 
Block 

Shift + F5 Clears all the data in an entire block. 

Insert Record F6 Insert a new, blank record in a table 

Clear Record Shift + F4 Clears all fields in a record. 

Delete Record Shift +F6 Deletes the selected record. 

Next Record Down Arrow Selects next record in a list of records. 

Previous 
Record 

Up Arrow Selects the previous record in a list of records. 

Select Record Shift + F3 Selects the current record. 

Record-Scroll 
Down 

Ctrl + L Scrolls down through a list of records. 

Record-Scroll 
Up 

Ctrl + P Scrolls up through a list of records. 

Next Field Tab 
Moves the cursor to the next enterable field in 
the form. 

Previous Field Shift + Tab 
Moves the cursor to the previous enterable field 
in the form. 

Clear Field Ctrl + U Clears the data in a field 

 

Return to Table of Contents 
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Appendix F:  Tips and Tricks 

This appendix contains tips and tricks for using Banner. 

Note:  If you have a tip or trick to add, please submit it to OIT, extension 4560. 

Entering Information: 

Topic Tip / Trick 

System Date 
In most date fields, entering a single non-numeric character will 
display the current date.  Remember, D for Date or T for Today.  
Forgot what day it is?  Enter ? in a date field and Banner will 
display it. Dates within the 

Current Month 

Enter 2 digits in a date field and Banner will assume the current 
month and year.  Entering 05 in September 2011 will display 05-
Sep-2011. 

Dates within the 
Current Year 

Enter 4 digits in a date field and Banner will assume the current 
year.  Entering 0509 in 2011 will display 05-Sep-2011. 

Populating 
Records on 
Forms 

After entering the SSN, click in the first enterable field and the 
record will be populated.  Note:  This works on about 80% of 
forms.  Remember to proceed out of a Key Block by using the Next 
Block function. Displaying a 

Field’s LOV 
(List of Values) 

Double clicking in a field that has a LOV will display the valid 
values for the field. 

Auto Hint and 
Status Line 

Pay attention to messages in these two areas.  Help messages 
and other information are continually displayed here. 

UTM Term 
Code 

A six digit code is assigned to each term.  1st four digits = Year, 2nd 
two digits = Term. 
20 = Spring, 30 = Summer, 40 = Fall, 50 = Full Year 
Example:  200640 = Fall Term of 2006.  

Navigation 

Topic Tip / Trick 

Open Multiple 
Forms 

From the Menu Bar, select File > Direct Access.  Enter the form 
name, and click Start.  The new form will open but the previous 
form will remain running in the background.  Note:  Only one form 
may be displayed at a time. 

Shortcuts in the 
Go To field 

Enter Site to navigate to the Site Map. 

 Enter Tree to navigate from the Site Map to the Product Tree. 
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Enter Refresh to refresh Personal Menu after changes, return to 
General Menu, or refresh the Site Map. 

 
Press the Up or Down arrow keys to navigate to any of the last 10 
forms accessed. 

 Enter the Menu name to expand that menu. 

 Enter Exit to end your Banner session. 

Rollback Use Rollback to clear the record and return to the Key Block. 

Calendar Double clicking in a date field will open the Calendar. 

Calculator Double clicking in a number field will open the Calculator. 

 

Queries 

Enter Query 
Always click the Enter Query button before entering and executing 
a query.  This ensures the form is in query mode. 

Re-executing a 
Query 

If no record has been selected after a query, perform two Enter 
Query functions in a row.  The first will clear the records; the 
second will retrieve the last set of criteria. 

Wildcards 
Use the _ (underscore) character to represent a single character 
and the % (percent) symbol to represent any number of continuous 
characters. 

 

Logging In/Out 

Enter Exit  to 
quit Banner 

Enter Exit in the Go To field to quit Banner and end the session. 

 

Miscellaneous 

Display 

 

 Maximize your Banner Title bar window. 
Upper left corner should look like this. 

 The computer monitor’s minimum display setting should be 
600x800 and set to small fonts. 
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